
使用する前に

この章では、Cisco ASAの使用を開始する方法について説明します。

•コマンドラインインターフェイス（CLI）のコンソールへのアクセス（1ページ）
• ASDMアクセスの設定（10ページ）
• ASDMの起動（16ページ）
• ASDM動作のカスタマイズ（18ページ）
•工場出荷時のデフォルト設定（20ページ）
•設定の開始（30ページ）
• ASDMでのコマンドラインインターフェイスツールの使用（31ページ）
•接続の設定変更の適用（33ページ）

コマンドラインインターフェイス（CLI）のコンソールへ
のアクセス

ASDMアクセスの基本的な設定を、CLIを使用して行う必要がある場合があります。

初期設定を行うには、コンソールポートから直接CLIにアクセスします。その後、#unique_39
に従って Telnetまたは SSHを使用して、リモートアクセスを設定できます。システムがすで
にマルチコンテキストモードで動作している場合は、コンソールポートにアクセスするとシ

ステムの実行スペースに入ります。

ASAvのコンソールアクセスについては、ASAvのクイックスタートガイドを参照してくださ
い。

（注）

アプライアンスコンソールへのアクセス

アプライアンスコンソールにアクセスするには、次の手順に従います。
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手順

ステップ 1 付属のコンソールケーブルを使用してコンピュータをコンソールポートに接続します。ター
ミナルエミュレータを回線速度 9600ボー、データビット 8、パリティなし、ストップビット
1、フロー制御なしに設定して、コンソールに接続します。

コンソールケーブルの詳細については、ASAのハードウェアガイドを参照してください。

ステップ 2 Enterキーを押して、次のプロンプトが表示されることを確認します。

ciscoasa>

このプロンプトは、ユーザEXECモードで作業していることを示します。ユーザEXECモード
では、基本コマンドのみを使用できます。

ステップ 3 特権 EXECモードにアクセスします。

enable

パスワードを入力するように求められます。デフォルトではパスワードは空白に設定されてい

るため、Enterキーを押して先に進みます。イネーブルパスワードを変更するには、ホスト名、
ドメイン名、およびイネーブルパスワードと Telnetパスワードの設定を参照してください。

例：

ciscoasa> enable
Password:
ciscoasa#

設定以外のすべてのコマンドは、特権EXECモードで使用できます。特権EXECモードからコ
ンフィギュレーションモードに入ることもできます。

特権モードを終了するには、disableコマンド、exitコマンド、または quitコマンドを入力し
ます。

ステップ 4 グローバルコンフィギュレーションモードにアクセスします。

configure terminal

例：

ciscoasa# configure terminal
ciscoasa(config)#

グローバルコンフィギュレーションモードからASAの設定を開始できます。グローバルコン
フィギュレーションモードを終了するには、exitコマンド、quitコマンド、または endコマン
ドを入力します。
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Firepower 4100/9300シャーシ上の ASAコンソールへのアクセス
初期設定の場合、Firepower 4100/9300シャーシスーパバイザに（コンソールポートに、ある
いは Telnetまたは SSHを使用してリモートで）接続してコマンドラインインターフェイスに
アクセスし、ASAセキュリティモジュールに接続します。

手順

ステップ 1 Firepower 4100/9300シャーシスーパバイザCLI（コンソールまたはSSH）に接続し、次にASA
にセッション接続します。

connect module slot console

初めてモジュールにアクセスするときは、FXOSモジュールのCLIにアクセスします。その後
ASAアプリケーションに接続する必要があります。

connect asa

例：

Firepower# connect module 1 console
Firepower-module1> connect asa

asa>

ステップ 2 最高の特権レベルである特権 EXECモードにアクセスします。

enable

パスワードを入力するように求められます。デフォルトではパスワードは空白に設定されてい

るため、Enterキーを押して先に進みます。イネーブルパスワードを変更するには、ホスト名、
ドメイン名、およびイネーブルパスワードと Telnetパスワードの設定を参照してください。

例：

asa> enable
Password:
asa#

設定以外のすべてのコマンドは、特権EXECモードで使用できます。特権EXECモードからコ
ンフィギュレーションモードに入ることもできます。

特権モードを終了するには、disableコマンド、exitコマンド、または quitコマンドを入力し
ます。

ステップ 3 グローバルコンフィギュレーションモードを開始します。

configure terminal

例：

asa# configure terminal
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asa(config)#

グローバルコンフィギュレーションモードを終了するには、disable、exit、または quitコマ
ンドを入力します。

ステップ 4 Ctrl-a、dと入力し、アプリケーションコンソールを終了して FXOSモジュール CLIに移動し
ます。

トラブルシューティングのために FXOSモジュールの CLIを使用する場合があります。

ステップ 5 FXOS CLIのスーパバイザレベルに戻ります。

a) ~と入力

Telnetアプリケーションに切り替わります。

b) Telnetアプリケーションを終了するには、次を入力します。

telnet>quit

ASAサービスモジュールコンソールへのアクセス
初期設定の場合、スイッチに（コンソールポートに、あるいは Telnetまたは SSHを使用して
リモートで）接続してコマンドラインインターフェイス（CLI）にアクセスし、ASASMに接
続します。ASASMには工場出荷時のデフォルトコンフィギュレーションが含まれていないた
め、ASDMを使用してアクセスする前にCLIで設定を行う必要があります。ここでは、ASASM
CLIにアクセスする方法について説明します。

接続方法について

スイッチ CLIから ASASMに接続するには、次の 2つの方法が使用できます。

•仮想コンソール接続：service-module sessionコマンドを使用して、ASASMへの仮想コン
ソール接続を作成します。仮想コンソール接続には、実際のコンソール接続のすべての利

点と制限があります。

利点を次に示します。

•接続はリロード中も持続し、タイムアウトしません。

• ASASMリロード中も接続を維持でき、スタートアップメッセージを閲覧できます。

• ASASMがイメージをロードできない場合、ROMMONにアクセスできます。

•初期パスワードの設定は必要ではありません。

制限を次に示します。

•接続が低速です（9600ボー）。

•一度にアクティブにできるコンソール接続は 1つだけです。
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•このコマンドは、Ctrl+Shift+6、xがターミナルサーバプロンプトに戻るためのエス
ケープシーケンスであるターミナルサーバとともに使用することはできません。

Ctrl+Shift+6、xは、ASASMコンソールをエスケープして、スイッチプロンプトに戻
るためのシーケンスでもあります。したがって、この状況でASASMを終了しようと
すると、代わりにターミナルサーバプロンプトに戻ります。スイッチにターミナル

サーバを再接続した場合、ASASMコンソールセッションがアクティブのままです。
スイッチプロンプトを終了することはできません。コンソールをスイッチプロンプ

トに戻すには、直接シリアル接続を使用する必要があります。この場合、Cisco IOS
でターミナルサーバまたはスイッチエスケープ文字を変更するか、または Telnet
sessionコマンドを使用します。

コンソール接続の永続性のため、ASASMを正しくログアウトし
ないと、意図よりも長く接続が存在する可能性があります。他の

人がログインする場合は、既存の接続を終了する必要がありま

す。

（注）

• Telnet接続：sessionコマンドを使用して、ASASMへの Telnet接続を作成します。

新しい ASASMに対してはこの方式を使用して接続できません。
この方式では、ASASM上での Telnetログインパスワードの設定
が必要です（デフォルトのパスワードはありません）。passwdコ
マンドを使用してパスワードを設定した後に、この方式を使用で

きます。

（注）

利点を次に示します。

• ASASMへの複数のセッションを同時に使用できます。

• Telnetセッションは、高速接続です。

制限を次に示します。

• Telnetセッションは、ASASMリロード時に終了し、タイムアウトします。

• ASASMが完全にロードするまで ASASMにはアクセスできません。したがって、
ROMMONにアクセスできません。

•最初にTelnetログインパスワードを設定する必要があります。デフォルトのパスワー
ドはありません。
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ASAサービスモジュールへのログイン

初期設定の場合、スイッチに（スイッチのコンソールポートに、あるいは Telnetまたは SSH
を使用してリモートで）接続してコマンドラインインターフェイスにアクセスし、ASASMに
接続します。

システムがすでにマルチコンテキストモードで動作している場合は、スイッチ環境からASASM
にアクセスするとシステムの実行スペースに入ります。

その後は、Telnetまたは SSHを使用してリモートアクセスを ASASMに直接設定できます。

手順

ステップ 1 スイッチから、次のいずれかを実行します。

•最初のアクセスで使用可能：スイッチ CLIからこのコマンドを入力し、ASASMにコン
ソールアクセスします。

service-module session [switch {1 | 2}] slot number

例：

Router# service-module session slot 3
ciscoasa>

VSS内のスイッチの場合、switch引数を入力します。

モジュールのスロット番号を表示するには、スイッチプロンプトで show moduleコマン
ドを入力します。

ユーザ EXECモードにアクセスします。

•ログインパスワードの設定後に使用可能：スイッチCLIからこのコマンドを入力し、バッ
クプレーンを介して ASASMに Telnet接続します。

session [switch {1 | | 2}] slot number processor 1

ログインパスワードの入力が求められます。

ciscoasa passwd:

例：

Router# session slot 3 processor 1
ciscoasa passwd: cisco
ciscoasa>

VSS内のスイッチの場合、switch引数を入力します。

session slot processor 0コマンドは、他のサービスモジュールではサポートされています
が、ASASMではサポートされていません。ASASMにはプロセッサ 0がありません。
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モジュールのスロット番号を表示するには、スイッチプロンプトで show moduleコマン
ドを入力します。

ASADMへのログインパスワードを入力します。passwdコマンドを使用してパスワード
を設定します。デフォルトのパスワードはありません。

ユーザ EXECモードにアクセスします。

ステップ 2 最高の特権レベルである特権 EXECモードにアクセスします。

enable

パスワードを入力するように求められます。デフォルトではパスワードは空白に設定されてい

るため、Enterキーを押して先に進みます。イネーブルパスワードを変更するには、ホスト名、
ドメイン名、およびイネーブルパスワードと Telnetパスワードの設定を参照してください。

例：

ciscoasa> enable
Password:
ciscoasa#

設定以外のすべてのコマンドは、特権EXECモードで使用できます。特権EXECモードからコ
ンフィギュレーションモードに入ることもできます。

特権モードを終了するには、disableコマンド、exitコマンド、または quitコマンドを入力し
ます。

ステップ 3 グローバルコンフィギュレーションモードにアクセスします。

configure terminal

グローバルコンフィギュレーションモードを終了するには、disableコマンド、exitコマンド、
または quitコマンドを入力します。

関連トピック

管理アクセスのガイドライン

ホスト名、ドメイン名、およびイネーブルパスワードと Telnetパスワードの設定

コンソールセッションのログアウト

ASASMからログアウトしない場合、コンソール接続は維持され、タイムアウトはありません。
ASASMコンソールセッションを終了してスイッチのCLIにアクセスするには、次の手順を実
行します。

意図せずに開いたままになっている可能性のある、別のユーザのアクティブな接続を終了する

には、アクティブなコンソール接続の終了（8ページ）を参照してください。
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手順

スイッチ CLIに戻るには、次を入力します。

Ctrl+Shift+6、x

スイッチプロンプトに戻ります。

asasm# [Ctrl-Shift-6, x]
Router#

米国および英国キーボードのShift+6はキャレット記号（^）を出力します。別のキー
ボードを使用しており、単独の文字としてキャレット記号（^）を出力できない場合、
一時的または永続的に、エスケープ文字を別の文字に変更できます。terminal
escape-character ascii_numberコマンド（このセッションで変更する）、またはdefault
escape-character ascii_numberコマンド（永続的に変更する）を使用します。たとえ
ば、現在のセッションのシーケンスを Ctrl-w、xに変更するには、
terminal escape-character 23を入力します。

（注）

アクティブなコンソール接続の終了

コンソール接続の永続性のために、ASASMを正しくログアウトしないと、意図したよりも長
い時間にわたって接続が存在する可能性があります。他の人がログインする場合は、既存の接

続を終了する必要があります。

手順

ステップ 1 スイッチ CLIから、show usersコマンドを使用して、接続されたユーザを表示します。コン
ソールユーザは「con」と呼ばれます。ホストアドレスは、127.0.0.slot0と表示されます（slot
はモジュールのスロット番号です）。

show users

たとえば、次のコマンド出力は、スロット 2にあるモジュールのライン 0のユーザ「con」を
示しています。

Router# show users
Line User Host(s) Idle Location
* 0 con 0 127.0.0.20 00:00:02

ステップ 2 コンソール接続のあるラインをクリアするには、次のコマンドを入力します。

clear line number

次に例を示します。
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Router# clear line 0

Telnetセッションのログアウト

Telnetセッションを終了してスイッチ CLIにアクセスするには、次の手順を実行します。

手順

スイッチ CLIに戻るには、ASASM特権モードまたはユーザ EXECモードから exitを入力しま
す。コンフィギュレーションモードに入っている場合は、Telnetセッションが終了するまで繰
り返し exitを入力します。

スイッチプロンプトに戻ります。

asasm# exit
Router#

代わりに、エスケープシーケンスCtrl+Shift+6、xを使用して、Telnetセッションをエ
スケープすることができます。このエスケープシーケンスを使用すると、スイッチ

プロンプトで Enterキーを押すことで、Telnetセッションを再開できます。スイッチ
から Telnetセッションを切断するには、スイッチ CLIで disconnectを入力します。
セッションを切断しない場合、ASASM設定に従って最終的にタイムアウトします。

（注）

ソフトウェアモジュールコンソールへのアクセス

ASA5506-XにASAFirePOWERなどのソフトウェアモジュールをインストールしている場合、
モジュールコンソールへのセッションを実行できます。

sessionコマンドを使用してASAバックプレーンを介してハードウェアモジュール CLIにアク
セスすることはできません。

（注）

手順

ASA CLIから、モジュールへのセッションを実行します。

session {sfr | cxsc | ips} console

例：
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ciscoasa# session sfr console
Opening console session with module sfr.
Connected to module sfr. Escape character sequence is 'CTRL-^X'.

Cisco ASA SFR Boot Image 5.3.1
asasfr login: admin
Password: Admin123

ASA 5506W-Xワイヤレスアクセスポイントコンソールへのアクセス
ワイヤレスアクセスポイントコンソールにアクセスするには、次の手順を実行します。

手順

ステップ 1 ASA CLIから、アクセスポイントへのセッションを実行します。

session wlan console

例：

ciscoasa# session wlan console
opening console session with module wlan
connected to module wlan. Escape character sequence is ‘CTRL-^X’

ap>

ステップ 2 アクセスポイント CLIについては、『Cisco IOS Configuration Guide for Autonomous Aironet
Access Points』[英語]を参照してください。

ASDMアクセスの設定
ここでは、デフォルトコンフィギュレーションで ASDMにアクセスする方法、およびデフォ
ルト設定がない場合にアクセスを設定する方法について説明します。

ASDMアクセス（アプライアンス、ASAv）に対する工場出荷時のデ
フォルトコンフィギュレーションの使用

工場出荷時のデフォルトコンフィギュレーションでは、ASDM接続はデフォルトのネットワー
ク設定で事前設定されています。
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手順

次のインターフェイスおよびネットワーク設定を使用して ASDMに接続します。

•管理インターフェイスは、ご使用のモデルによって異なります。

• Firepower 4100/9300：展開時に定義された管理タイプインターフェイスと IPアドレ
ス。管理ホストは任意のネットワークからアクセスできます。

• ASA 5506-X、ASA5508-XおよびASA5516-X：内部GigabitEthernet 1/2（192.168.1.1）
および ASA 5506W-X、Wi-Fi GigabitEthernet 1/9（192.168.10.1）用。内部ホストは
192.168.1.0/24ネットワークに限定され、Wi-Fiホストは 192.168.10.0/24に限定されま
す。

• ASA 5512-X以降：管理 0/0（192.168.1.1）。管理ホストは 192.168.1.0/24ネットワー
クに限定されます。

• ASA：管理 0/0（導入時に設定）。管理ホストは管理ネットワークに限定されます。

• ISA 3000：管理 1/1（192.168.1.1）。管理ホストは 192.168.1.0/24ネットワークに限定
されます。

マルチコンテキストモードに変更すると、上記のネットワーク設定を使用して管理

コンテキストから ASDMにアクセスできるようになります。
（注）

関連トピック

工場出荷時のデフォルト設定（20ページ）
マルチコンテキストモードの有効化またはディセーブル化

ASDMの起動（16ページ）

ASDMアクセスのカスタマイズ
この手順は、ASAサービスモジュールを除くすべてのモデルに適用されます。

次の条件に 1つ以上当てはまる場合は、この手順を使用します。

•工場出荷時のデフォルトコンフィギュレーションがない。

•トランスペアレントファイアウォールモードに変更したい。

•マルチコンテキストモードに変更したい。

シングルルーテッドモードの場合、ASDMに迅速かつ容易にアクセスするために、独自の管
理 IPアドレスを設定できるオプションを備えた工場出荷時のデフォルトコンフィギュレーショ
ンを適用することを推奨します。この項に記載されている手順は、特別なニーズ（トランスペ

アレントモードやマルチコンテキストモードの設定など）がある場合や、他の設定を維持す

る必要がある場合にのみ使用してください。
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ASAvの場合、導入時にトランスペアレントモードを設定できるため、この手順は、設定をク
リアする必要がある場合など、導入後に特に役立ちます。

（注）

手順

ステップ 1 コンソールポートで CLIにアクセスします。

ステップ 2 （オプション）トランスペアレントファイアウォールモードをイネーブルにします。

このコマンドは、設定をクリアします。

firewall transparent

ステップ 3 管理インターフェイスを設定します。

interface interface_id
nameif name
security-level level
no shutdown
ip address ip_address mask

例：

ciscoasa(config)# interface management 0/0
ciscoasa(config-if)# nameif management
ciscoasa(config-if)# security-level 100
ciscoasa(config-if)# no shutdown
ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0

security-levelは、1～ 100の数字です。100が最も安全です。

ステップ 4 （直接接続された管理ホスト用）管理ネットワークの DHCPプールを設定します。

dhcpd address ip_address-ip_address interface_name
dhcpd enable interface_name

例：

ciscoasa(config)# dhcpd address 192.168.1.2-192.168.1.254 management
ciscoasa(config)# dhcpd enable management

その範囲にインターフェイスアドレスが含まれていないことを確認します。

ステップ 5 （リモート管理ホスト用）管理ホストへのルートを設定します。

route management_ifc management_host_ip mask gateway_ip 1

例：

使用する前に
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ciscoasa(config)# route management 10.1.1.0 255.255.255.0 192.168.1.50 1

ステップ 6 ASDMの HTTPサーバをイネーブルにします。

http server enable

ステップ 7 管理ホストの ASDMへのアクセスを許可します。

http ip_address mask interface_name

例：

ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

ステップ 8 設定を保存します。

write memory

ステップ 9 （オプション）モードをマルチモードに設定します。

mode multiple

プロンプトが表示されたら、既存の設定を管理コンテキストに変換することを承認します。

ASAをリロードするよう求められます。

例

次の設定では、ファイアウォールモードがトランスペアレントモードに変換され、

Management 0/0インターフェイスが設定され、管理ホストに対してASDMがイネーブ
ルにされます。

firewall transparent
interface management 0/0

ip address 192.168.1.1 255.255.255.0
nameif management
security-level 100
no shutdown

dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management
http server enable
http 192.168.1.0 255.255.255.0 management

関連トピック

工場出荷時のデフォルト設定の復元（21ページ）
ファイアウォールモード（シングルモード）の設定

アプライアンスコンソールへのアクセス（1ページ）
ASDMの起動（16ページ）
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ASAサービスモジュールの ASDMアクセスの設定
ASASMには物理インターフェイスがないため、ASDMアクセスが事前設定されていません。
ASASMの CLIを使用して ASDMアクセスを設定する必要があります。ASDMアクセス用に
ASASMを設定するには、次の手順を実行します。

始める前に

ASASMのクイックスタートガイドに従って、ASASMにVLANインターフェイスを割り当て
ます。

手順

ステップ 1 ASASMに接続し、グローバルコンフィギュレーションモードにアクセスします。

ステップ 2 （オプション）トランスペアレントファイアウォールモードをイネーブルにします。

firewall transparent

このコマンドは、設定をクリアします。

ステップ 3 ご使用のモードに応じて、次のいずれかの操作を行って管理インターフェイスを設定します。

•ルーテッドモード：インターフェイスをルーテッドモードで設定します。

interface vlan number
ip address ip_address [mask]
nameif name
security-level level

例：

ciscoasa(config)# interface vlan 1
ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0
ciscoasa(config-if)# nameif inside
ciscoasa(config-if)# security-level 100

security-levelは、1～ 100の数字です。100が最も安全です。

•トランスペアレントモード：ブリッジ仮想インターフェイスを設定し、ブリッジグルー
プに管理 VLANを割り当てます。

interface bvi number
ip address ip_address [mask]

interface vlan number
bridge-group bvi_number
nameif name
security-level level

例：

使用する前に
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ciscoasa(config)# interface bvi 1
ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0

ciscoasa(config)# interface vlan 1
ciscoasa(config-if)# bridge-group 1
ciscoasa(config-if)# nameif inside
ciscoasa(config-if)# security-level 100

security-levelは、1～ 100の数字です。100が最も安全です。

ステップ 4 （直接接続された管理ホスト用）管理インターフェイスネットワーク上の管理ホストのDHCP
をイネーブルにします。

dhcpd address ip_address-ip_address interface_name
dhcpd enable interface_name

例：

ciscoasa(config)# dhcpd address 192.168.1.2-192.168.1.254 inside
ciscoasa(config)# dhcpd enable inside

この範囲内には管理アドレスを含めないでください。

ステップ 5 （リモート管理ホスト用）管理ホストへのルートを設定します。

route management_ifc management_host_ip mask gateway_ip 1

例：

ciscoasa(config)# route management 10.1.1.0 255.255.255.0 192.168.1.50

ステップ 6 ASDMの HTTPサーバをイネーブルにします。

http server enable

ステップ 7 管理ホストの ASDMへのアクセスを許可します。

http ip_address mask interface_name

例：

ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

ステップ 8 設定を保存します。

write memory

ステップ 9 （オプション）モードをマルチモードに設定します。

mode multiple
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プロンプトが表示されたら、既存の設定を管理コンテキストに変換することを承認します。

ASASMをリロードするよう求められます。

例

次のルーテッドモードの設定では、VLAN 1のインターフェイスを設定し、管理ホス
トの ASDMのイネーブルにします。

interface vlan 1
nameif inside
ip address 192.168.1.1 255.255.255.0
security-level 100

dhcpd address 192.168.1.3-192.168.1.254 inside
dhcpd enable inside
http server enable
http 192.168.1.0 255.255.255.0 inside

次の設定では、ファイアウォールモードをトランスペアレントモードに変換し、VLAN
1インターフェイスを設定して BVI 1に割り当てた後、管理ホストの ASDMをイネー
ブルにします。

firewall transparent
interface bvi 1

ip address 192.168.1.1 255.255.255.0
interface vlan 1
bridge-group 1
nameif inside
security-level 100

dhcpd address 192.168.1.3-192.168.1.254 inside
dhcpd enable inside
http server enable
http 192.168.1.0 255.255.255.0 inside

関連トピック

ASAサービスモジュールコンソールへのアクセス（4ページ）
接続方法について（4ページ）
コンソールセッションのログアウト（7ページ）
アクティブなコンソール接続の終了（8ページ）
Telnetセッションのログアウト（9ページ）
ファイアウォールモード（シングルモード）の設定

ASDMの起動
ASDMは、次の 2つの方法で起動できます。

使用する前に
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• ASDM-IDMランチャ：ランチャは、ASAからWebブラウザを使用してダウンロードされ
るアプリケーションです。これを使用すると、任意の ASA IPアドレスに接続できます。
他の ASAに接続する場合、ランチャを再度ダウンロードする必要はありません。

• Java Web Start：管理する ASAごとにWebブラウザで接続して、Java Web Startアプリケー
ションを保存または起動する必要があります。任意でコンピュータにショートカットを保

存できます。ただし、ASA IPアドレスごとにショートカットを分ける必要があります。

Web Startを使用する場合は、Javaキャッシュをクリアしてください。クリアしない場合、
Hostscanなどのログイン前ポリシーに対する変更が失われる可能性があります。この問題は、
ランチャを使用している場合には発生しません。

（注）

ASDMでは、管理のために別の ASA IPアドレスを選択できます。ランチャと Java Web Start
の機能の違いは、主に、ユーザが最初にどのように ASAに接続し、ASDMを起動するかにあ
ります。

ここでは、まずASDMに接続する方法について説明します。次にランチャまたは JavaWebStart
を使用して ASDMを起動する方法について説明します。

ASDMはローカルの \Users\<user_id>\.asdmディレクトリ内にキャッシュ、ログ、および設定な
どのファイルを保存し、Tempディレクトリ内にもAnyConnectプロファイルなどのファイルを
保存します。

手順

ステップ 1 ASDMクライアントとして指定したコンピュータで次の URLを入力します。

https://asa_ip_address/admin

次のボタンを持つ ASDM起動ページが表示されます。

• Install ASDM Launcher and Run ASDM

• Run ASDM

• Run Startup Wizard

ステップ 2 ランチャをダウンロードするには、次の手順を実行します。

a) [Install ASDM Launcher and Run ASDM]をクリックします。
b) ユーザ名とパスワードのフィールドを空のままにし（新規インストールの場合）、[OK]を
クリックします。HTTPS認証が設定されていない場合は、ユーザ名およびイネーブルパ
スワード（デフォルトで空白）を入力しないで ASDMにアクセスできます。注：HTTPS
認証をイネーブルにした場合、ユーザ名と関連付けられたパスワードを入力します。認証

が有効でない場合でも、ログイン画面で（ユーザ名をブランクのままにしないで）ユーザ

名とパスワードを入力すると、ASDMによってローカルデータベースで一致がチェックさ
れます。

使用する前に
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c) インストーラをコンピュータに保存して、インストーラを起動します。インストールが完
了すると、ASDM-IDMランチャが自動的に開きます。

d) 管理 IPアドレス、および同じユーザ名とパスワード（新規インストールの場合は空白）を
入力し、[OK]をクリックします。

ステップ 3 Java Web Startを使用するには：

a) [Run ASDM]または [Run Startup Wizard]をクリックします。
b) プロンプトが表示されたら、ショートカットをコンピュータに保存します。オプション
で、アプリケーションを保存せずに開くこともできます。

c) ショートカットから Java Web Startを起動します。
d) 表示されたダイアログボックスに従って、任意の証明書を受け入れます。CiscoASDM-IDM

Launcherが表示されます。
e) ユーザ名とパスワードのフィールドを空のままにし（新規インストールの場合）、[OK]を
クリックします。HTTPS認証が設定されていない場合は、ユーザ名およびイネーブルパ
スワード（デフォルトで空白）を入力しないで ASDMにアクセスできます。注：HTTPS
認証をイネーブルにした場合、ユーザ名と関連付けられたパスワードを入力します。認証

が有効でない場合でも、ログイン画面で（ユーザ名をブランクのままにしないで）ユーザ

名とパスワードを入力すると、ASDMによってローカルデータベースで一致がチェックさ
れます。

ASDM動作のカスタマイズ
アイデンティティ証明書をインストールしてASDMを正常に起動するだけでなく、ASDMヒー
プメモリを増大することもできるため、より大きいサイズのコンフィギュレーションを処理で

きます。

ASDMのアイデンティティ証明書のインストール
Java 7 Update 51以降を使用する場合、ASDMランチャには信頼できる証明書が必要です。証
明書の要件は、自己署名付きの ID証明書をインストールすることによって簡単に満たすこと
ができます。証明書をインストールするまで、Java Web Startを使用して ASDMを起動するこ
とができます。

ASDMで使用するためにASAに自己署名された ID証明書をインストールし、Javaを使用して
証明書を登録するには、次のマニュアルを参照してください。

http://www.cisco.com/go/asdm-certificate

ASDMコンフィギュレーションメモリの増大
ASDMでサポートされる最大設定サイズは 512 KBです。このサイズを超えると、パフォーマ
ンスの問題が生じることがあります。たとえば、コンフィギュレーションのロード時には、完

了したコンフィギュレーションの割合がステータスダイアログボックスに表示されます。この
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とき、サイズの大きいコンフィギュレーションでは、ASDMによってまだコンフィギュレー
ションの処理が行われていても、完了した割合の増分が停止し、操作が中断されているように

見えます。このような状況が発生した場合は、ASDMシステムヒープメモリの増大を検討す
ることを推奨します。

Windowsでの ASDMコンフィギュレーションメモリの増大

ASDMヒープメモリサイズを増大するには、次の手順を実行して run.batファイルを編集し
ます。

手順

ステップ 1 ASDMインストールディレクトリ（たとえば、C:\Program Files (x86)\Cisco Systems\ASDM）に
移動します。

ステップ 2 任意のテキストエディタを使用して run.batファイルを編集します。

ステップ 3 「start javaw.exe」で始まる行で、「-Xmx」のプレフィックスが付いた引数を変更し、目的の
ヒープサイズを指定します。たとえば、768 MBの場合は -Xmx768Mに変更し、1 GBの場合
は -Xmx1Gに変更します。

ステップ 4 run.batファイルを保存します。

Mac OSでの ASDMコンフィギュレーションメモリの増大

ASDMヒープメモリサイズを増大するには、次の手順を実行して Info.plist ファイルを編集し
ます。

手順

ステップ 1 [Cisco ASDM-IDM]アイコンを右クリックし、[Show Package Contents]を選択します。

ステップ 2 [Contents]フォルダで、Info.plistファイルをダブルクリックします。開発者ツールをインストー
ルしている場合は、プロパティリストエディタで開きます。そうでない場合は、TextEditで
開きます。

ステップ 3 [Java]> [VMOptions]で、「-Xmx」のプレフィックスが付いた文字列を変更し、必要なヒープ
サイズを指定します。たとえば、768MBの場合は -Xmx768Mに変更し、1GBの場合は -Xmx1G
に変更します。
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ステップ 4 このファイルがロックされると、次のようなエラーが表示されます。

ステップ 5 [Unlock]をクリックし、ファイルを保存します。

[Unlock]ダイアログボックスが表示されない場合は、エディタを終了します。[CiscoASDM-IDM]
アイコンを右クリックし、[CopyCiscoASDM-IDM]を選択して、書き込み権限がある場所（デ
スクトップなど）に貼り付けます。その後、このコピーからヒープサイズを変更します。

工場出荷時のデフォルト設定
工場出荷時のデフォルト設定とは、シスコが新しい ASAに適用したコンフィギュレーション
です。

• ASA5506-X、5508-Xおよび 5516-X：工場出荷時のデフォルト設定により、機能内部/外部
設定が有効になります。ASAは、内部インターフェイスから ASDMを使用して管理でき
ます。

• ASA5512-X～ASA5585-X：管理用のインターフェイスは工場出荷時のデフォルト設定に
よって設定されるため、ASDMを使用してこのインターフェイスに接続して設定を完了で
きます。

• Firepower4100/9300シャーシ：ASAのスタンドアロンまたはクラスタを展開する場合、管
理用のインターフェイスは工場出荷時のデフォルト設定によって設定されるため、ASDM
を使用してこのインターフェイスに接続して設定を完了できます。

• ASAv：ハイパーバイザによっては、導入の一環として、管理用のインターフェイス導入
設定（初期の仮想導入設定）によって設定されるため、ASDMを使用してこのインター
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フェイスに接続して設定を完了できます。フェールオーバー IPアドレスも設定できます。
また、必要に応じて、「工場出荷時のデフォルト」コンフィギュレーションを適用するこ

ともできます。

• ASASM：デフォルト設定はありません。コンフィギュレーションを開始するには、ASA
サービスモジュールコンソールへのアクセス（4ページ）を参照してください。

• ISA 3000：工場出荷時のデフォルト設定は、同じネットワーク上のすべての内部および外
部インターフェイスを使用した、ほぼ完全なトランスペアレントファイアウォールモー

ド設定です。ASDMを使用して管理インターフェイスに接続し、ネットワークの IPアド
レスを設定できます。ハードウェアバイパスは2つのインターフェイスペアに対して有効
になっており、すべてのトラフィックはインラインタップモニタ専用モードで ASA
FirePOWERモジュールに送信されます。このモードでは、モニタリング目的でのみトラ
フィックの重複ストリームが ASA Firepowerモジュールに送信されます。

アプライアンス および Firepower 4100/9300シャーシの場合、工場出荷時のデフォルト設定
は、ルーテッドファイアウォールモードとシングルコンテキストモードのみで使用できます。

ASAvの場合、導入時にトランスペアレントモードまたはルーテッドモードを選択できます。

イメージファイルと（隠された）デフォルトコンフィギュレーションに加え、log/、
crypto_archive/、および coredumpinfo/coredump.cfgがフラッシュメモリ内の標準のフォルダと
ファイルです。フラッシュメモリ内で、これらのファイルの日付は、イメージファイルの日

付と一致しない場合があります。これらのファイルは、トラブルシューティングに役立ちます

が、障害が発生したことを示すわけではありません。

（注）

工場出荷時のデフォルト設定の復元

この項では、工場出荷時のデフォルトコンフィギュレーションを復元する方法について説明し

ます。CLIおよびASDMの両方の手順が提供されています。ASAvでは、この手順を実行する
ことで導入設定が消去され、ASA 5525-Xの場合と同じ工場出荷時のデフォルト設定が適用さ
れます。

ASASMで出荷時のデフォルトコンフィギュレーションを復元すると、設定は消去されます。
工場出荷時のデフォルトコンフィギュレーションはありません。

Firepower 4100/9300では、工場出荷時のデフォルト設定を復元すると単に設定が消去されるだ
けです。デフォルト設定を復元するには、スーパバイザから ASAをもう一度展開する必要が
あります。

（注）

始める前に

この機能は、ルーテッドファイアウォールモードでのみ使用できます。トランスペアレント

モードの場合、インターフェイスの IPアドレスがサポートされません。さらに、この機能は
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シングルコンテキストモードでのみ使用できます。コンフィギュレーションがクリアされた

ASAには、この機能を使用して自動的に設定する定義済みコンテキストがありません。

手順

ステップ 1 工場出荷時のデフォルトコンフィギュレーションを復元します。

configure factory-default [ip_address [mask]]

例：

ciscoasa(config)# configure factory-default 10.1.1.1 255.255.255.0

ip_addressを指定する場合は、デフォルトの IPアドレスを使用する代わりに、お使いのモデル
に応じて、内部または管理インターフェイスの IPアドレスを設定します。ip_addressオプショ
ンで設定されているインターフェイスについては、次のモデルのガイドラインを参照してくだ

さい。

• Firepower 4100/9300：効果はありません。

• ASAv：管理インターフェイスの IPアドレスを設定します。

• ASA 5506-X：内部インターフェイスの IPアドレスを設定します。

• ASA 5508-Xおよび 5516-X：内部インターフェイスの IPアドレスを設定します。

• ASA 5512-X、5515-X、5525-X、5545-X、5555-X：管理インターフェイスの IPアドレスを
設定します。

• ASA 5585-X：管理インターフェイスの IPアドレスを設定します。

• ISA 3000：管理インターフェイスの IPアドレスを設定します。

• ASASM：効果はありません。

httpコマンドでは、ユーザが指定するサブネットが使用されます。同様に、dhcpd addressコ
マンドの範囲は、指定したサブネット内のアドレスで構成されます。

Firepower 2100の場合：このモデルでは、boot systemコマンドは使用されません。パッケージ
は FXOSによって管理されます。

その他すべてのモデルの場合：このコマンドは、残りの設定とともに boot systemコマンドを
クリアします（存在する場合）。boot systemコマンドを使用すると、特定のイメージから起
動できます。出荷時の設定に戻した後、次回 ASAをリロードすると、内部フラッシュメモリ
の最初のイメージからブートします。内部フラッシュメモリにイメージがない場合、ASAは
ブートしません。

ステップ 2 デフォルトコンフィギュレーションをフラッシュメモリに保存します。

write memory
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このコマンドでは、事前に boot configコマンドを設定して、別の場所を設定していた場合で
も、実行コンフィギュレーションはスタートアップコンフィギュレーションのデフォルトの場

所に保存されます。コンフィギュレーションがクリアされると、このパスもクリアされます。

ステップ 3 （ASDMでの手順。）メイン ASDMアプリケーションウィンドウで、次を実行します。

a) [File] > [Reset Device to the Factory Default Configuration]の順に選択します。

[Reset Device to the Default Configuration]ダイアログボックスが表示されます。

b) （オプション）デフォルトアドレスを使用する代わりに、管理または内部インターフェイ
スの管理 IPアドレスを入力します。

モデルごとに設定されているインターフェイス IPの詳細については、前述の CLI手順を
参照してください。

c) （オプション）ドロップダウンリストから [Management Subnet Mask]を選択します。
d) [OK]をクリックします。

確認用のダイアログボックスが表示されます。

Firepower 2100の場合：このモデルでは、ブートイメージの場所は使用されませ
ん。パッケージは FXOSによって管理されます。

その他すべてのモデルの場合：この操作により、残りの設定とともにブートイ

メージの場所もクリアされます（存在する場合）。[Configuration] > [Device
Management] > [System Image/Configuration] > [Boot Image/Configuration]ペインで
は、外部メモリ上のイメージを含む、特定のイメージからブートできます。出荷

時の設定に戻した後、次回 ASAをリロードすると、内部フラッシュメモリの最
初のイメージからブートします。内部フラッシュメモリにイメージがない場合、

ASAはブートしません。

（注）

e) [Yes]をクリックします。
f) デフォルト設定を復元したら、この設定を内部フラッシュメモリに保存します。[File] >

[Save Running Configuration to Flash]を選択します。

このオプションを選択すると、以前に別の場所を設定している場合でも、実行コンフィ

ギュレーションがスタートアップコンフィギュレーションのデフォルトの場所に保存され

ます。コンフィギュレーションをクリアした場合は、このパスもクリアされています。

ASAv導入設定の復元
この項では、ASAvの導入（第 0日）設定を復元する方法について説明します。

手順

ステップ 1 フェールオーバーを行うために、スタンバイ装置の電源を切ります。
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スタンバイユニットがアクティブになることを防ぐために、電源をオフにする必要がありま

す。電源を入れたままにした場合、アクティブ装置の設定を消去すると、スタンバイ装置がア

クティブになります。以前のアクティブユニットをリロードし、フェールオーバーリンクを

介して再接続すると、古い設定は新しいアクティブユニットから同期し、必要な導入コンフィ

ギュレーションが消去されます。

ステップ 2 リロード後に導入設定を復元します。フェールオーバーを行うために、アクティブ装置で次の
コマンドを入力します。

write erase

ASAvが現在の実行イメージをブートするため、元のブートイメージには戻りませ
ん。元のブートイメージを使用するには、boot imageコマンドを参照してください。

コンフィギュレーションは保存しないでください。

（注）

ステップ 3 ASAvをリロードし、導入設定をロードします。

reload

ステップ 4 フェールオーバーを行うために、スタンバイ装置の電源を投入します。

アクティブ装置のリロード後、スタンバイ装置の電源を投入します。導入設定がスタンバイ装

置と同期されます。

ASA 5506-X、5508-X、および 5516-Xのデフォルト設定
ASA5506-Xシリーズ、5508-X、および5516-Xの工場出荷時のデフォルト設定は、次のとおり
です。

•内部 -->外部へのトラフィックフロー：GigabitEthernet 1/1（外部）、GigabitEthernet 1/2
（内部）

• DHCPの外部 IPアドレス、内部 IPアドレス：192.168.1.1

•（ASA 5506W-X）WiFi<-->内部のトラフィックフロー、WiFi -->外部へのトラフィック
フロー：GigabitEthernet 1/9（WiFi）

•（ASA 5506W-X）WiFiの IPアドレス：192.168.10.1

•内部およびWiFi上のクライアントに対する DHCP。アクセスポイント自体とそのすべて
のクライアントが ASAを DHCPサーバとして使用します。

•管理1/1インターフェイスが稼働しているが、そうでない場合は未設定。ASAFirePOWER
モジュールは、このインターフェイスを使用して ASA内部ネットワークに接続し、内部
インターフェイスをインターネットへのゲートウェイとして使用できます。

• ASDMアクセス：内部ホストとWiFiホストが許可されます。
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• NAT：内部、WiFi、および管理から外部へのすべてのトラフィックのインターフェイス
PAT。

このコンフィギュレーションは次のコマンドで構成されています。

interface Management1/1
management-only
no nameif
no security-level
no ip address
no shutdown

interface GigabitEthernet1/1
nameif outside
security-level 0
ip address dhcp setroute
no shutdown

interface GigabitEthernet1/2
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown

!
object network obj_any
subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface

!
http server enable
http 192.168.1.0 255.255.255.0 inside
!
dhcpd auto_config outside
dhcpd address 192.168.1.5-192.168.1.254 inside
dhcpd enable inside
!
logging asdm informational

ASA 5506W-Xの場合は、次のコマンドも含まれます。

same-security-traffic permit inter-interface
!
interface GigabitEthernet 1/9
security-level 100
nameif wifi
ip address 192.168.10.1 255.255.255.0
no shutdown

!
http 192.168.10.0 255.255.255.0 wifi
!
dhcpd address 192.168.10.2-192.168.10.254 wifi
dhcpd enable wifi

ASA 5512-X～ ASA 5585-Xデフォルト設定
ASA 5512-X～ ASA 5585-Xの工場出荷時のデフォルト設定は、次のとおりです。

•管理インターフェイス：Management 0/0（管理）。

• IPアドレス：管理アドレスは 192.168.1.1/24です。

使用する前に
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• DHCPサーバ：管理ホストでは DHCPサーバがイネーブルにされているため、管理イン
ターフェイスに接続するコンピュータには、192.168.1.2～ 192.168.1.254の間のアドレスが
割り当てられます。

• ASDMアクセス：管理ホストに許可されます。

このコンフィギュレーションは次のコマンドで構成されています。

interface management 0/0
ip address 192.168.1.1 255.255.255.0
nameif management
security-level 100
no shutdown

!
asdm logging informational
asdm history enable
!
http server enable
http 192.168.1.0 255.255.255.0 management
!
dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management

Firepower 4100/9300シャーシデフォルト設定
Firepower 4100/9300シャーシ上に ASAを展開した場合、ASDMを使用して管理インターフェ
イスへの接続が可能になる多くのパラメータを事前設定できます。一般的な構成には次の設定

があります。

•管理インターフェイス：

• Firepower 4100/9300シャーシスーパバイザ上で定義された任意の管理タイプインター
フェイス

•名前は「management」

•任意の IPアドレス

•セキュリティレベル 0

•管理専用

•管理インターフェイス内のデファルトルート

• ASDMアクセス：すべてのホストが許可されます。

スタンドアロンユニットの設定は、次のコマンドで構成されます。クラスタユニットの追加

の設定については、ASAクラスタの作成を参照してください。

interface <management_ifc>
management-only
ip address <ip_address> <mask>
ipv6 address <ipv6_address>
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ipv6 enable
nameif management
security-level 0
no shutdown

!
http server enable
http 0.0.0.0 0.0.0.0 management
http ::/0 management
!
route management 0.0.0.0 0.0.0.0 <gateway_ip> 1
ipv6 route management ::/0 <gateway_ipv6>

ISA 3000のデフォルト設定
ISA 3000の工場出荷時のデフォルト設定は、次のとおりです。

•トランスペアレントファイアウォールモード：トランスペアレントファイアウォールは、
「Bump In The Wire」または「ステルスファイアウォール」のように動作するレイヤ 2
ファイアウォールであり、接続されたデバイスへのルータホップとしては認識されませ

ん。

• 1ブリッジ仮想インターフェイス：すべてのメンバーインターフェイスは同じネットワー
ク内に存在しています（IPアドレスは事前設定されていません。ネットワークと一致する
ように設定する必要があります）：GigabitEthernet 1/1（outside1）、GigabitEthernet 1/2
（inside1）、GigabitEthernet 1/3（outside2）、GigabitEthernet 1/4（inside2）

•すべての内部および外部インターフェイスは相互通信できます。

•管理 1/1インターフェイス：ASDMアクセスの 192.168.1.1/24。

•管理上のクライアントに対する DHCP。

• ASDMアクセス：管理ホストに許可されます。

•ハードウェアバイパスは、次のインターフェイスペアで有効になっています。
GigabitEthernet 1/1および 1/2。GigabitEthernet 1/3および 1/4

ISA 3000への電源が切断され、ハードウェアバイパスモードに
移行すると、通信できるのは上記のインターフェイスペアのみに

なります。inside1と inside2および outside1と outside2は通信でき
なくなります。これらのインターフェイス間の既存の接続がすべ

て失われます。電源が再投入されると、ASAがフローを引き継ぐ
ため、接続が短時間中断されます。

（注）

• ASA Firepowerモジュール：すべてのトラフィックが、Inline Tap Monitor-Onlyモードのモ
ジュールに送信されます。このモードでは、モニタリング目的でのみトラフィックの重複

ストリームが ASA Firepowerモジュールに送信されます。

このコンフィギュレーションは次のコマンドで構成されています。
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firewall transparent

interface GigabitEthernet1/1
bridge-group 1
nameif outside1
security-level 0
no shutdown

interface GigabitEthernet1/2
bridge-group 1
nameif inside1
security-level 100
no shutdown

interface GigabitEthernet1/3
bridge-group 1
nameif outside2
security-level 0
no shutdown

interface GigabitEthernet1/4
bridge-group 1
nameif inside2
security-level 100
no shutdown

interface Management1/1
management-only
no shutdown
nameif management
security-level 100
ip address 192.168.1.1 255.255.255.0

interface BVI1
no ip address

access-list allowAll extended permit ip any any
access-group allowAll in interface outside1
access-group allowAll in interface outside2

same-security-traffic permit inter-interface

hardware-bypass GigabitEthernet 1/1-1/2
hardware-bypass GigabitEthernet 1/3-1/4

http server enable
http 192.168.1.0 255.255.255.0 management

dhcpd address 192.168.1.5-192.168.1.254 management
dhcpd enable management

access-list sfrAccessList extended permit ip any any
class-map sfrclass
match access-list sfrAccessList

policy-map global_policy
class sfrclass
sfr fail-open monitor-only

service-policy global_policy global

ASAv導入設定
ASAv上にASAを展開した場合、ASDMを使用して管理 0/0インターフェイスへの接続が可能
になる多くのパラメータを前もって設定できます。一般的な構成には次の設定があります。
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•ルーテッドファイアウォールモードまたはトランスペアレントファイアウォールモード

• Management 0/0インターフェイス：

•名前は「management」

• IPアドレスまたは DHCP

•セキュリティレベル 0

•管理ホスト IPアドレスのスタティックルート（管理サブネット上にない場合）

• HTTPサーバの有効または無効

•管理ホスト IPアドレス用の HTTPアクセス

•（オプション）GigabitEthernet0/8用のフェールオーバーリンク IPアドレス、Management0/0
のスタンバイ IPアドレス

• DNSサーバ

•スマートライセンス IDトークン

•スマートライセンスのスループットレベルおよび標準機能ティア

•（オプション）Smart Call Home HTTPプロキシ URLおよびポート

•（オプション）SSH管理設定：

•クライアント IPアドレス

•ローカルユーザ名とパスワード

•ローカルデータベースを使用する SSHに必要な認証

•（オプション）REST APIの有効または無効

Cisco認証局に正常に登録するには、ASAvをインターネットアクセスが必要です。インター
ネットアクセスを実行して正常にライセンス登録するには、導入後に追加の設定が必要になる

ことがあります。

（注）

スタンドアロンユニットについては、次の設定例を参照してください。

interface Management0/0
nameif management
security-level 0
ip address ip_address

no shutdown
http server enable
http managemment_host_IP mask management
route management management_host_IP mask gateway_ip 1
dns server-group DefaultDNS
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name-server ip_address
call-home
http-proxy ip_address port port

license smart
feature tier standard
throughput level {100M | 1G | 2G}
license smart register idtoken id_token

aaa authentication ssh console LOCAL
username username password password
ssh source_IP_address mask management
rest-api image boot:/path
rest-api agent

フェールオーバーペアのプライマリユニットについては、次の設定例を参照してください。

nameif management
security-level 0
ip address ip_address standby standby_ip

no shutdown
route management management_host_IP mask gateway_ip 1
http server enable
http managemment_host_IP mask management
dns server-group DefaultDNS
name-server ip_address

call-home
http-proxy ip_address port port

license smart
feature tier standard
throughput level {100M | 1G | 2G}
license smart register idtoken id_token

aaa authentication ssh console LOCAL
username username password password
ssh source_IP_address mask management
rest-api image boot:/path
rest-api agent
failover
failover lan unit primary
failover lan interface fover gigabitethernet0/8
failover link fover gigabitethernet0/8
failover interface ip fover primary_ip mask standby standby_ip

設定の開始
ASAを設定してモニタするには、次の手順を実行します。

ASDMでは、最大 512 KBの設定をサポートしています。このサイズを超えると、パフォーマ
ンスの問題が生じることがあります。ASDMコンフィギュレーションメモリの増大（18ペー
ジ）を参照してください。

（注）
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手順

ステップ 1 Startup Wizardを使用して初期設定を行うには、[Wizards] > [Startup Wizard]を選択します。

ステップ 2 IPsec VPNWizardを使用して IPsec VPN接続を設定するには、[Wizards] > [IPsecVPNWizard]を
選択して、表示される各画面で設定を行います。

ステップ 3 SSL VPNWizardを使用して SSL VPN接続を設定するには、[Wizards] > [SSL VPNWizard]を選
択して、表示される各画面で設定を行います。

ステップ 4 高可用性とスケーラビリティに関する設定値を設定するには、[Wizards] > [High Availability and
Scalability Wizard]を選択します。

ステップ 5 PacketCaptureWizardを使用してパケットキャプチャを設定するには、[Wizards] > [PacketCapture
Wizard]を選択します。

ステップ 6 ASDM GUIで使用できるさまざまな色とスタイルを表示するには、[View] > [Office Look and
Feel]を選択します。

ステップ 7 機能を設定するには、ツールバーの [Configuration]ボタンをクリックし、いずれかの機能ボタ
ンをクリックして、関連する設定ペインを表示します。

[Configuration]画面が空白の場合は、ツールバーで [Refresh]をクリックして、画面の
コンテンツを表示します。

（注）

ステップ 8 ASAをモニタするには、ツールバーの [Monitoring]ボタンをクリックし、機能ボタンをクリッ
クして、関連するモニタリングペインを表示します。

ASDMでのコマンドラインインターフェイスツールの使
用

この項では、ASDMを使用してコマンドを入力する方法およびCLIの使用方法について説明し
ます。

コマンドラインインターフェイスツールの使用

この機能には、コマンドを ASAに送信して結果を表示する、テキストベースのツールが用意
されています。

CLIツールによって入力可能なコマンドは、ユーザ権限によって異なります。メインASDMア
プリケーションウィンドウの下部にあるステータスバーの権限レベルを見て、CLI特権コマン
ドを実行するために必要な特権があるかどうかを確認してください。

始める前に

• ASDMの CLIツールから入力するコマンドは、ASAの接続ターミナルから入力するコマ
ンドと動作が異なる場合があります。
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•コマンドエラー：誤った入力コマンドによってエラーが発生した場合、その誤ったコマン
ドはスキップされ、その他のコマンドは処理されます。[Response]領域には、他の関連情
報とともに、エラーが発生したかどうかについての情報を示すメッセージが表示されま

す。

•インタラクティブコマンド：インタラクティブコマンドは、CLIツールではサポートさ
れていません。これらのコマンドをASDMで使用するには、次のコマンドに示すように、
noconfirmキーワード（使用可能な場合）を使用します。

crypto key generate rsa modulus 1024 noconfirm

•他の管理者との競合を回避：複数の管理ユーザが ASAの実行コンフィギュレーションを
アップデートできます。ASDMの CLIツールでコンフィギュレーションを変更する場合
は、アクティブな管理セッションが他にないことを事前に確認してください。複数のユー

ザが同時に ASAを設定した場合、最新の変更が有効になります。

同じASAで現在アクティブな他の管理セッションを表示するには、[Monitoring]>[Properties]
> [Device Access]の順に選択します。

手順

ステップ 1 メイン ASDMアプリケーションウィンドウで、[Tools] > [Command Line Interface]の順に選
択します。

[Command Line Interface]ダイアログボックスが表示されます。

ステップ 2 必要なコマンドのタイプ（1行または複数行）を選択し、ドロップダウンリストからコマンド
を選択するか、または表示されたフィールドにコマンドを入力します。

ステップ 3 [Send]をクリックしてコマンドを実行します。

ステップ 4 新しいコマンドを入力するには、[ClearResponse]をクリックしてから、実行する別のコマンド
を選択（または入力）します。

ステップ 5 この機能の状況依存ヘルプを表示するには、[Enable context-sensitive help (?)]チェックボックス
をオンにします。文脈依存ヘルプをディセーブルにするには、このチェックボックスをオフに

します。

ステップ 6 設定を変更した場合は、[Command Line Interface]ダイアログボックスを閉じた後に、[Refresh]
をクリックして ASDMでの変更内容を表示します。

ASDMによって無視されるコマンドのデバイス上での表示
この機能により、ASDMがサポートしていないコマンドの一覧を表示できます。通常 ASDM
は、これらのコマンドを無視します。ASDMは、実行コンフィギュレーションのこれらのコマ
ンドを変更、削除することはありません。詳細については、「サポートされていないコマン

ド」を参照してください。
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手順

ステップ 1 メイン ASDMアプリケーションウィンドウで、[Tools] > [Show Commands Ignored by ASDM
on Device]の順に選択します。

ステップ 2 完了したら、[OK]をクリックします。

接続の設定変更の適用
コンフィギュレーションに対してセキュリティポリシーの変更を加えた場合は、すべての新し

い接続で新しいセキュリティポリシーが使用されます。既存の接続は、接続の確立時に設定さ

れたポリシーを引き続き使用します。古い接続のshowコマンド出力には古い設定が反映され、
古い接続に関するデータを含まない場合があります。

たとえば、インターフェイスから QoS service-policyを削除し、修正バージョンを再度追加す
る場合、show service-policyコマンドには、新しいサービスポリシーと一致する新規接続と関
連付けられている QoSカウンタのみ表示されます。古いポリシーの既存の接続はコマンド出
力には表示されません。

すべての接続が新しいポリシーを確実に使用するように、現在の接続を解除し、新しいポリ

シーを使用して再度接続できるようにします。

接続を解除するには、次のいずれかのコマンドを入力します。

• clear local-host [ip_address] [all]

このコマンドは、接続制限値や初期接続の制限など、クライアントごとのランタイムス

テートを再初期化します。これにより、このコマンドは、これらの制限を使用しているす

べての接続を削除します。ホストごとの現在のすべての接続を表示するには、showlocal-host
allコマンドを参照してください。

引数を指定しないと、このコマンドは、影響を受けるすべての through-the-box接続をクリ
アします。to-the-box接続もクリアするには（現在の管理セッションを含む）、allキーワー
ドを使用します。特定の IPアドレスへの、または特定の IPアドレスからの接続をクリア
するには、ip_address引数を使用します。

• clear conn[all] [protocol {tcp |udp}] [ address src_ip [-src_ip] [ netmask mask] [ port src_port
[-src_port] [ address dest_ip [-dest_ip] [ netmask mask] [ port dest_port [-dest_port]

このコマンドは、すべての状態の接続を終了します。現在のすべての接続を表示するに

は、show connコマンドを参照してください。

引数を指定しないと、このコマンドはすべての through-the-box接続をクリアします。
to-the-box接続もクリアするには（現在の管理セッションを含む）、allキーワードを使用
します。送信元 IPアドレス、宛先 IPアドレス、ポート、プロトコルに基づいて特定の接
続をクリアするには、必要なオプションを指定できます。
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